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Class VI
Chapter 1

SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (a), (c) 4. (b) 5. (b) 
B. 1. F 2. T 3. F 4. F 5. T 6. T
C.

Hardware Software
The hardware of the computer are physi-
cal equipments that are directly involved 
in data-processing and communication 
functions.

The software of the computer are the 
programs and languages that control the 
functioning of the hardware and perform 
various tasks.

D. 1. Bit: A bit is defined as a variable or computed quantity which can have only two 
values. A bit is the short term of binary digit. These binary digits are denoted by 0 
and 1.

 2. Byte: A byte is a unit of digital information which consits of eight bits. A byte of 
information is stored by using many bits in a predefined construction.

 3. Field: A field is a collection of bytes which hold a single fact. For eg: Consider a 
data field like 24 August 2012. This data contains three fields namely date, month 
and year.

 4. Record: Records are composed of fields, each of which contains one item of infor-
mation. A set of records constitutes a file.

E. 1. A computer becomes a complete system only when hard wores and softwares are 
combined together. Both the hardware and software of the computer are required 
for the working of a computer. Both of them are complementary to each other. 
Hardware of the computer is an one-time expense of the computer while software 
of the computer is a continuing expense.

  For example: If you buy a hard disk then you can store large amount of data in it. 
There is no need to buy hard disk regularly. But it is different in case of software 
as you need to buy various softwares to let the computer perform different tasks.

 2. Computer hardwares are the parts that can be seen or touched. Without hardware a 
computer cannot run. All computer setups require a disk drive (like hard drive etc), 
monitor, keyboard, motherboard, Processor, Powersupply and video card in order 
to function properly. If any of these devices have any problem or are not found, an 
error would be encountered and the computer would not start.

 3. It is possible to run a computer without a software being installed on it. But in 
some cases, if an operating system or an interpreter is not found on the computer 
then it would generate an error or show a blank screen on the monitor.

CO-SCHOLASTIC TASK
A. Do yourself
B. Data is the numerical, alphabetical or any other information that is represented in the 
form which is acceptable by the computer for Processing. Data hierarchy is the system-
atic organisation of data in the form of a hierarchy. It involves bits, bytes, fields, records 
files and database.
C. Do yourself (Refer pg no 9 of book)
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Chapter 2
SCHOLASTIC TASK
A. 1. (d) 2. (a) 3. (b) 4. (a)
B. 1. Disk, Scanner, hard drive 2. Administor Password, submit or continue 3. Download-
ed Program files, Temporary Internet files. 4. System Restore 5. two
C. 1. Disk Scanner is a utility program which can detect both physical and logical prob-

lems in the hard drive. It corrects these problems of the computer system. It also 
removes all the unnecessary files.

 2. Disk cleanup is used to reduce the number of unnecessary files on the hard disk 
to free up disk space and help the computer run faster. It removes temporary files, 
empties the Recycle Bin and removes a variety of system files and other items that 
are no longer used.

 3. If there is any problem in the computer system then you can use the system Re-
store feature. This system will be restored to the previous point after which the 
problem occured.

 4. Following are the steps to use Disk Scanner on the computer system:
 i) Click on start button.
 ii) Click on computer.
  The computer window will appear.
 iii) All the hard drives will be visible. Click on the hard drive whose problems you 

want to check.
 iv) Click on properties. The properties dialog box will appear.
 v) Click on Tools tab.
 vi) Click on check now.
  When the User Account Control dialog box appears then type the administrator 

password and click submit or click continue.
  The CheckDisk dialog box will appear.
 vii) Click on any one of check boxes.
 1. Automatically fix file system errors:
  To let check Disk fix the errors.
 2. Scan for and attempt recovery of bad sectors: To let check Disk look for bad factors.
 viii) Click on start button
  The hard drive check begins.
 ix) After the drive check is over a dialog box will appear stating — click to schedule 

the scan disk when you restart windows.
 x) Click on ok to return back to the hard drive of the computer.
 5. Following are the steps to use Disk Cleanup in your computer system:
 i) Click on start button.
   The start menu will appear.
 ii) Click on All Programs.
 iii) Click on Accessories.
 iv) Click on System Tools.
 v) Click on Disk cleanup.
  The Drive selection dialog box will appear.
 vi) Click on the down arrow to select the drive you want to clean.
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 vii) Click on OK.
 viii) Click on the hard drive you want to clean.
  You will see the Disk cleanup dialog box.
  This area tells the total amount of disk space you can clean.
  This area displays the various categories of Disk cleanup.
 ix) Just click on the box to check mark the files you want to clean.
 x) After selecting the files, click on Ok.
  A confimation dialog box will appear.
 xi) Click on Delete files.
  The unnecessary files will be deleted.
 6. Following are the steps to create a system restore point:
 i) Click on start button.
 ii) Right click on the computer button.
  A list of menu will appear.
 iii) Click on Properties.
  The system window will appear.
 iv) Click on system protection.
  The system properties dialog box will appear.
 v) Click on the system protection tab.
 vi) Click on create.
 vii) The system protection dialog box will appear.
  Enter the description for your restore point.
 viii) Click on create.
  A confirmation box will appear to confirm the creation of the restore point.
 ix) Click on close.
 x) Click on Ok.
 xi) Click on the close button. 
  The system properties window will be closed.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself
C. Do yourself

Chapter 3
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (a) 4. (a)
B. 1. BASIC, COBOL, PASCAL
 2. SUB for subtraction.
 3. Interpreters and compilers.
 4. Yes.
 5. Machine language uses binary digits 0 and 1 to make instructions to the computer.
 6. No.
 7. There are two major types of programming languages:
  1. Low Level Languages.
  2. High Level Languages.
 8. Machine language and Assembly language.
C. Complete the table.
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D. 1. Being an electronic machine a computer can feel only electricity. It cannot un-
derstand human languages. So, a computer can understand a language which is 
directly related to electricity.

  A computer can understand only machine language which consists of binary digits 
0 and 1.

 2. Low Level Languages are languages which can be used only on one computer. 
These languages run on a particular computer and cannot be used on other com-
puter.

  The two types of Low Level languages are:
  i) Machine language
  ii) Assembly language
  Machine language:
  It is uses binary digits 0 and 1, to make instructions to the computer
  Assembly Languages:
  It is difficult to write programs in Machine language. So, Assembly language was 

developed which used lines and symbols to write programs instead of 0 and 1.
 3. The language which is not dependent on computers is known as high level lan-

guage. A computer understands only machine language. High level language are 
converted into machine language through interpreters and compilers.

  High level languages consist of Third-Generation languages and Fourth-Genera-
tion languages.

CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself

Chapter 4
SCHOLASTIC TASK
A. 1. (c) 2. (d) 3. (c) 4. (c) 
B.  Do it yourself
C. 1. An outline view shows the outline levels in the documents.
 2. Draft view displays the documents without graphics.
 3. Following are the steps to run macro using the keyboard shortcut:
 i) Point the insertion point to the place where you want the macro to appear.

Programming
Language

High Level
Language

Low Level
Language

Machine
Language

Assembly
Language

Third
Generation
Language

Fourth
Generation
Language

Natural
Language
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 ii) Press the keyboard shortcut key assigned to the macro.
  Your result will appear.
 4. Mail Merge feature helps us to create letters for our friends and relatives in Micro-

soft Word 2010. It has some default formats like letters, envelopes etc.
 5. Following are the five views of the Microsoft Word 2010 document:
  Print layout, Full Screen Reading Layout, Web Layout, Outline, Draft.
  Following are the steps to view Microsoft Word 2010 document in Fun Screen 

Reading Layout View:
 i) Click on view tab.
 ii) You will see all the five view on the ribbon. Click on Full Screen Reading Layout.
  Your document will be displayed in Full Screen Reading Layout.
 6. Following are the steps to customise Quick Access Toolbar:
 i) Click on customise Quick Access Toolbar button on the title bar.
  A drop down list of menu will appear.
 ii) Click on More commands.
  The word options dialog box will appear.
 iii) Click on down arrow button to display all the categories of commands.
 iv) Click on the category of commands you want to select.
  Let us click on File tab.
 v) All the commands in the File tab category will appear. Click on the command you 

want to add to the toolbar.
 vi) Click on Add.
  Now, the new command will appear in the list. 
 vii) click on Ok.
  To add more commands repeat the above steps and add commands of your choice.
The new command appears in the Quick Access Toolbar.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do youself

Assessment A
A. 1. Machine language: 
  Machine language is the lowest and most elementary level of programming language 

and was the first type of programming language.
 2. Assembly language: 
  The assembly uses lines and symbols to write the programs instead of 0 and 1.
 3. Third-generation language: 
  Third-generation language use English-like words to write the programs. Third-gen-

eration languages are also translated into Machine language through compilers and 
interpreters.

 4. Fourth-Generation languages:
  Fourth generation also use English-like words to write programs. Visual Basic, 

Java, oracle are examples of some fourth generation languages.
 5. Natural Languages:
  Natural languages are also known as fifth-generation languages. In this language, 

human speech is used to type any query into the computer.
B.   A computer like any other machine needs maintainence. A Properly maintained 
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computer will provide you with substaintial speed. The Disk scanner helps to re-
move the unnecessary files. If there is any problem in the computer system then you 
can use the system Restore feature. If we want to reduce the number of unnecessary 
files on the hard disk space and help our computer run faster, use Disk cleanup.

C. Do yourself.

Assessment B
A. 1. The hardware of the computer are physical equipments that are directly involved in 

data-processing and communication functions.
 2. The software of the computer are the programs and languages that control the func-

tioning of the hardware and perform various tasks.
 3. Examples of hardware:
  Monitor, Mouse etc.
 4. Examples of software:
  Windows, Operating system etc.
 5. A computer becomes a complete system only when hardwares and softwares are 

combined together. Both the hardware and software of the computer are required 
for working of a compuer. Hardware of the computer is an one-time expense for the 
computer while software of the computer is a continuing expense.

B.       Do yourself.

Test Paper A
SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (d) 4. (a) 5. (d) 6. (c)
B. 1. F 2. T 3. F 4. F 5. T 6. T
C. 1. hard disk, scanner 2. administrator Password, submit or continue 3. Download Pro-
gram Files, Recycle bin 4. System Restore 5. two
D. 1. BASIC, COBOL, PASCAL
 2. It uses interpreters and compilers
 3. Yes
 4. It uses the binary digits 0 and 1 to make instructions to the computer.
E. 

Hardware Software
The hardware of the computer are physi-
cal equipments that are directly involved 
in data processing and communication 
functions. 

The softwate of the computer are the 
programs and languages that control the 
functioning of the hardware and perform 
various tasks.

F. 1. A computer becomes a complete system only when hardwares and software are 
combined together. Both of them are complementary to each other. Hardware of the 
computer is an one-time expense for the computer while software of the computer 
is a continuing expense.

  For example: If you buy a hard disk men you store large amount of data in it. There 
is no need to buy hard disk regularly. But it is different in case of software. You need 
to buy various software to let the computer perform different tasks.

 2. Following are the steps to use Disk Cleanup in your computer system:
 i) Click on the start button.
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  The start menu will appear.
 ii) Click on All Programs.
 iii) Click on Accessories.
 iv) Click on System Tools).
 v) Click on Disk Cleanup.
 3. The language which is not dependent on computers is known as high level lan-

guage.
  This is a user-friendly language as it uses English-like language. A computer only 

understands machine language, so it is necessary to convert high level language 
into machine language so that computer can process the result. High level languag-
es are converted into machine language through interpreters and compilers.

 4. Zoom In and Zoom out features are used to enlarge or reduce the page of your 
document Zoom In enables you to increase the size of the document. Zoom out 
enables you to decrease the size of the doucment. You can Zoom In and Zoom Out 
the page by the following two methods:

 ● By using Zoom slider
 ● By using view Tab.
  Following are the steps to zoom In and Zoom out the document by the two methods:
By using Zoom slider.
 1. When you open Microsoft Word 2010 document, you will see the following but-

tons on the right bottom corner of the document.

 2. Drag these buttons to the left to zoom out and to the right to Zoom In.
  By using view Tab.
 1. Open Microsoft Word 2010 document.
 2. Click on the view Tab.
 3. Click on the zoom button.
  The Zoom dialog box will appear.
 4. Click on Zoom settings you want to apply to the document.
 5. Click on Ok.
You will see the document with the new zoom setting.

Chapter 5
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (d) 4. (c) 5. (b)
B. 1. Copy 2. Paste 3. Worksheet Window 4. Sheet 1, Sheet 2, Sheet 3
C. Do it yourself.
D. 1. Cut 2. Copy 3. Paste
E. 1. Following are the steps to edit data in Microsoft Excel 2010 worksheet:
 i) Open the worksheet in which you want to correct the mistakes.
 ii) Double-click on the cell whose data you want to edit.
  A flashing insertion point will appear in the cell.
 iii) Press the arrows keys of the keyboard to move the insertion point to the area where 

Print Layout : It shows margins, headers and footers.

Full Screen Reading Layout :  It displays your documents on full

screen and makes reading easy for you.

Web Layout : It displays your documents as a web page.

Outline :It shows the outline levels in the documents.

Draft : It displays the documents without graphics.
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you want to add the character.
 iv) Enter the character from the keyboard.
 v) Press the arrow keys of the keyboard to move the insertion point to the place from 

where you want to delete a character.
 vi) Press the delete key on the keyboard to delete.
 vii) After you have made the changes, Press the enter key.
 2. Following are the steps to delete a row:
 i) Click on the heading of the row you want to delete.
 ii) Click on the Home tab.
 iii) Click on the Delete button.
  A drop down list of commands will appear.
 iv) Click on Delete Sheet Rows. The row will be deleted.
Following are the steps to delete a column:
 i). Click on the heading of the column you want to delete.
 ii). Click on the Home tab button.
 iii). Click on the Delete button.
  A drop down list of commands appear.
 iv). Click on Delete sheet columns.
  The column will be deleted.
 3. Following are the steps to insert a column/row:
 i) Click the heading of the column/row to the right where you want to insert a column/ 

row.
 ii) Click on the Hometab.
 iii) Click on the down arrow of insert.
  A drop down list of commands will appear.
 iv) Click on Insert Sheet Rows/column. 
  The new row/column will appear and all the rows/columns will shift downwards/ 

right resp.
 4. Following are the steps to cut or copy data and paste it into another cell:
 i) Select the cell that contains the data you want to move or copy.
 ii) Click on the Home tab.
 iii) Click anyone button
   To cut text

   To copy text
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 iv) Click on the cell on which you want to copy or move data.

 v) Click on the Paste button.
  Your data will appear in the new cell.
 5. Follow the step to add an additional worksheet in Microsoft Excel 2010 workbook:
  Click on the Insert workbook icon on the bottom of the page.
  A new worksheet will appear in the worksheet tab. It will be named as sheet 4 

(default name). You can change the name of the worksheet by the steps taught in 
Penaming a sheet topic.

Following are the steps to delete the worksheet:
 1. Click on the worksheet you want to delete to make it active.
 2. Right click on the tab.
  A drop down menu list will appear.
 3. Click on Delete.
  Your worksheet is deleted if it is empty.
 4. If the worksheet is not empty, a text box is prompted for deletion.
 5. Click on Delete.
  Now, your worksheet will be deleted.
CO-SCHOLASTIC TASK
A. Microsoft Excel is a spreadsheet developed by Microsoft for Windows, Mac Os, 
Android and Ios. It features graphing tools, Pivot tables and also a macro Programing 
language which is called Visual Basic for Applications. Since version 5 it has been a very 
widely applied worksheet.
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B. Do yourself.
C. Do yourself.

Chapter 6
SCHOLASTIC TASK
A. 1. (d) 2. (c) 3. (c) 4. (a) 5. (c)
B. 

Constant values Formulas
Constant values are the values which are 
directly entered in the cell. They consist 
of text, numerals and alpha numerals, etc.

Formulas contain various mathematical 
operators, functions, etc. They perform all 
the calculations on Microsoft Excel data.

C. Some of the commonly used arithmetical operators are given below:
 1 : Used for addition
 2 : Used for subtraction
 3 : Used for Multiplication
 / : Used for division
 % : Used for Percent
 ⋀ : Used for exponentiation
Following are some of the commonly used comparison operators:
 5 : Equal to
 . : Greater than
 , : Less than
 . 5 : Greater than or equal to
 , 5 : Less than or equal to
 , . : Not equal to
D. 1. When Microsoft Excel is not able to calculate the answer properly or display it prop-
erly an error message will be seen.

A
1. 5
2. 4
3. Nisha
4. #value

A
1. 5
2. 4
3. Nisha
4. #Name?

This cell contains the given 
formula:
A1+A2+A3
The error occurs because the 
cell A3 does not contain num-
bers. It contains a text value.

This cell contains the given 
formula:
A1+AM+A3
The error occurs because the 
cell reference A2 was typed 
incorrectly as AM
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A
1. 18
2.
3. #Div/01

A
1. 17223
2. 15472
3. # # # #

This cell contains the given 
formula:
A1/A2
The empty cell is considered 
as displaying the value O. So, 
Microsoft Excel 2010 divide 
18 by 0 which is not possible. 
Hence, the error occurs.

This cell contains the given 
formula:
A1+A2
The error occurs because the 
result is too narrow to display 
in the cell.

 2. Following are the steps to create formula:
 i) Click on the cell in which you want to enter a formula.
 ii) Type (=) sign to start the formula.
 iii) Click on the first cell whose value you want to enter into the formula.
  The cell reference is automatically entered after '=' sign.
 iv) Now type an operator (+) for the formula.
 v) Click on the next cell to enter the value.
  The second cell reference is also entered.
 vi) Now repeat the above two steps to enter the value to other cells.
 vii) Press the enter key.
  The result will be displayed in the cell immediately, you can see the formula in the 

formula bar.
 3. Some Microsoft Excel 2010 functions are:—
  ASC function
  BAHTTEXT function
  CHAR function
  CLEAN function
  CODE function
  CONCATENATE function
  DOLLAR function
  EXACT function
  FIND, FINDB function
  FIXED function
  JIS function
  LEFT, LEFT B function
  LEN, LENB functions
  LOWER function
  MID, MIDB functions
  PHONETIC function
  PROPER function
  REPLACE, REPLACEB functions
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  REPT function
  RIGHT, RIGHTB functions
  SEARCH, SEARCHB functions
  SUBSTITUTE function.
  T function
  TEXT function
  TRIM function
  UPPER function
  VALUE function
 4. Following are the steps to enter a function in Microsoft Excel 2010:
 i) Click on the cell you want to enter the function.
 ii) Click on the Insert function button fx.
  The Insert function dialog box will appear.
 iii) Click on the down arrow button of select a category to select a category of functions.
 iv) Click on the function you want to use.
 v) Now select a function you want to use.
 vi) Click on OK.
 vii) The function Arguments dialog box will appear.
  This area displays the boxes in which you enter the value. This area describes the 

numbers you can enter.
 viii) Click on the cell that contains the first number.
  The cell reference will appear in the first box.
 ix) Click on the next box to enter the next number.
 x) Repeat the above steps to enter the cell reference.
 xi)  After the numbers are entered, click on OK.
 5. Following are the steps to perform calculations using functions:
 i) Click on the cell on which you want to perform the calculation using functions.
 ii) Click on the Hometab.
 iii) Click on the down arrow of the AutoSum button.
  A drop down list of some functions will appear.
 iv) Click to the function you want to use for your calculation.
  A moving outline will appear around the cells that Microsoft Excel 2010 will 

include in the calculation.
  The function you selected will appear in the cell you selected in Step 1.
  The function will also be visible in the formula bar.
 i) Press the enter key to display the result in the selected.
CO-SCHOLASTIC TASK
A. Microsoft Excel 2010 contains data. There are two types of data in Microsoft Excel 

2010 namely.
1. Constant values
2. Formulas
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Constant values Formulas
Constant values are the values which are 
directly entered in the cell. They consist 
of text, numerals, alpha numerals, etc.

Formulas contain various mathematical 
operators, functions, etc. The perform all 
the calculations on Microsoft Excel data.

B. Do yourself.

Chapter 7
SCHOLASTIC TASK
A. 1. (c) 2. (d) 3. (b) 4. (c) 5. (c)
B. 1. Search box 2. pictures, graphics, music files, videos 3. PDF 4. Period 5. Google 6. tab
C. 1. 69.171.237.32
 2. 74.125.236.146
 3. 106.10.170.118
 4. 208.80.154.225
D. 1. Internet gives you access to more information, entertainment and ways to commu-

nicate than most of us ever thought it possible.
  The internet is made up of millions of computers from all around the world, linked 

to each other by a network of telephone lines, cables and satellite connections.
 2. Every computer has its own unique identification attached to it. This unique iden-

tification is used to connect to the internet. This is called the IP address. IP address 
stands for Internet Protocol address.

  Let us see example IP address of some famous website.
  IP address
  69.171.237.32
  74.125.236.146
 3. Domain name system (DNS) is the internet system that stores the domain name 

and the IP address of the website domain name.
  www.facebook.com
  www.google.com
  www.yahoo.com
 4. Following are the steps to open a website using domain name:-
 i) Open Internet Explorer.
 ii) Enter the following domain name in the address bar.
  www.wikipedia.com
 iii) Press the enter key or click on the →  button.
  The home page of wikipedia will appear in the Internet Explorer window.
 5. Follow these steps to open a homepage:
  Open Internet Explorer
  The home page will appear automatically. 
 6. Following are the steps to open a new tab in the current window:
 i) Click on the New tab icon.
  A new tab will appear displaying the home page.
 ii) Enter the web page address you want to visit.
 iii) Press the enter key.
  The web page will appear in the new tab.
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 7. Following are the steps to add web page to favorites:
 i) Open the web page you want to add to favourites.
 ii) Click on favorites button (). A drop down lsit of menu will appear.
 iii) Click on Add on favourites. The Add on favourite dialog box will appear.
  The name of the web page appears in the Name text box.
 iv) Click on Add button.
  The web page is added to your favourites list.
 v) To view your favourite web page click on the favorites button.
  A list will appear.
 vi) Click on the name of the web page. Your favourite web page will be displayed.
 8. Following are the steps to clear the browsing history of Internet Explorer window:
 i) Open Internet Explorer.
 ii) Click on the safety button.
  A list of menu appears.
 iii) Click on Delete Browsing History.
  The Delete Browsing History dialog box will appear.
 iv) Click on the check box of History.
 v) Click on Delete.
  All your browsing history is now cleared.
 9. E-commerce refers to businesses and consumers buying and selling products on-

line. The majority of E-commerce websites on the Internet are retail stores selling 
products directly to the public E-commerce does not only refer to the selling of 
physical products, it can also refer to the selling of services where payments for 
the services are made online.

CO-SCHOLASTIC TASK
A. Internet is very popular now-a- days as it is being used in almost each and every field. 

Some of the uses of internet are:
 1. Access Information: You can use Internet to search information about any topic.
 2. E-mail: Internet is used to send and receive messages to and from your family 

members, relatives and friends.
 3. Entertainment: Internet is used for many entertainment purposes like listening 

songs, watching videos, etc.
 4. Online Studies and Tests: You can visit various online websites to search the 

matter related to your studies. You can easily download PDT books related to your 
studies and also apply for online tests over the internet.

 5. Online Shopping: Internet is used to buy and sell products online.
 6. Chatting: Internet enables you to talk to another person instantly.
B. Do yourself
C. Do yourself

Assessment C
A. Do yourself
B. 1. You can use internet to search information on any topic.
 2. Internet is used for many entertainment purposes like listening songs, watching vid-

eos, etc. You can even watch live matches, concerts, etc using internet.

Assessment D
A. Microsoft Excel 2010 formulas contain various mathematical, operators, functions, 
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etc. They perform all the calculations on Microsoft Excel data.
 Microsoft Excel 2010 contains some built-in formulas that are used to perform vari-

ous calculations in a worksheet. These are known as functions. There are more than 
300 functions in Microsoft Excel 2010 like AVERAGE, COUNT, SUM, MAX, MIN 
etc.

B. Do yourself.

Test Paper B
A. 1. (a) 2. (a) 3. (c) 4. (c)
B. 

Functions Formulas
Constant values are the values which are 
directly entered in the cell. They consist 
of text, numerals, alpha numerals etc. 

Formulas contain various mathematical 
operators, functions, etc. They perform all 
the calculations on Microsoft Excel data.

C. Do yourself
D. Do yourself
E. 1. 69.171.237.32
 2. 74.125.236.146
 3. 106.10.170.118
 4. 208.80.154.225
F. 1. Following are the steps to delete a row:
 i) Click on the heading of the row you want to delete.
 ii) Click on the Home tab.
 iii) Click on the Delete button.
  A drop down list of commands will appear.
 iv) Click on Delete Sheet Rows. 
  The row will be deleted.
 Following are the steps to delete a column:
 1. Click on the heading of the column you want to delete.
 2. Click on the Home tab button.
 3. Click on the Delete button
  A drop down list of commands appear.
 4. Click on Delete Sheet columns:
  The column will be deleted.
 2. Some Microsoft Excel 2010 functions are:
  ASC function
  BAHTTEXT function
  CHAR function
  CLEAN function
  CODE function
  CONCATENATE function
  DOLLAR function
  EXACT function
  FIND, FINDB functions.
  FIXED function
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  JIS function
  LEFT, LEFTB functions
  LEN, LENB functions
  LOWER functions
  MID, MIDB functions
  PHONETIC function
  PROPER function
  REPLACE, REPLACEB functions
  REPT function
  RIGHT, RIGHTB functions
  SEACH, SEARCH B functions
  SUBSTITUTE function
  T function
  TEXT function
  TRIM function
  UPPER function
  VALUE function
 3. Following are the steps to perform calculations using functions:
 i) Click on the cell on which you want to perform the calculation using functions.
 ii) Click on the Home tab.
 iii) Click on the down arrow of the AutoSum button.
 iv) Click on the function you want to use for your calculation.
  A moving outline will appear around the cells that Microsoft Excel 2010 will 

include in the calculation.
  The function you selected will appear in the cell you selected in Step 1.
  The function will also be visible in the formula bar.
 v) Press the enter key to display the result in the selected cell.
 4. Follow the step to open a home page of Internet explorer:
  Open Internet Explorer The home page will appear automatically.
 5. Following are the steps to clear the browsing history of Internet Explorer window:
 i) Open Internet Explorer
 ii) Click on the safety button.
  A list of menu appears.
 iii) Click on Delete Browsing History.
  The Delete Browsing History dialog box will appear.
 iv) Click on the check box of History.
 v) Click on Delete.
  All your browsing history is now cleared.
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Class VII
Chapter 1

SCHOLASTIC TASK
A. 1. (c) 2. (c) 3. (d) 4. (c)
B. 1. Single user 2. Multitasking 3. User 4. Switch 5. Share
C. 1. T 2. F 3. F 4. T 5. F
D. 

Single tasking Multitasking
1. Single tasking operating system is designed 

to manage the computer so that users can 
effectively do one thing at a time.

2. Example: Palm Handheld computer

1. Multitasking is the type of operating 
system most people use on their 
desktop and laptops today.

2. Example:- Microsoft Windows

E. 1. Following are the steps to create a user account:
 i) Click on the start button.
  The start menu will appear.
 ii) Click on control panel.
  The control Panel window will appear.
 iii) Click on Add or remove user accounts.
  The manage Accounts window will appear.
 iv) Click on Create a new account.
  Create New Account window will appear.
 v) Type a name for the New Account.
 vi) Now, select the account type from the following options:
   Standard
   Administrator
 vii) Click on create Account.
  The new account will be created and appear in the Manage Accounts window.
 2. Following are the steps to assign password to the user account:
 i) Open the Manage Accounts window from the Control Panel.
 ii) Click on the user account to which you want to assign the password.
  Change an Account window will appear.
 iii) Click on create a Password.
  Create Password window will appear.
 iv) Type a password in the first box.
 v) Now, re-type the password in the second box.
 vi) You can create a Password hint so that you don't forget the passoword. Type the 

password hint.
 vii) Click on create Password.
  The user account Password is created. Now, account is secured with the Password.
  The change an Account window will appear.
 viii) Click on close button.
 3. Following are the steps to switch between user accounts:
 i) Click on the start button. The name of the current user will appear on the start 

menu.
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 ii) Click on the arrow of the shut down button.
  A drop down list of menu will appear.
 iii) Click on Switch user.
  The welcome screen will appear.
 iv) Click on the user account name to which you want to switch.
 v) If the account is protected by a password, enter the password and click on   button.
  Now the user Account desktop will appear.
 vi) Click on start button.
  Now, the name and picture of the new user account will appear in the start menu.
 4. Following are the steps to change the user account picture:
 i) Open the Manage Accounts Window from control Panel.
 ii) Click on the user account whose picture you want to change.
  The User Accounts Window will appear.
 iii) Click on change your picture.
  Then choose your picture window will appear.
  A list of pictures will appear.
 iv) Click on the picture you want to use the user account.
 v) Click on Change Picture. The User Accounts Window will appear displaying the 

new account picture.
 vi) Click on close button.
 5. Following are the steps to delete user account:
 i) Open the Manage Accounts window.
 ii) Click on the User Account which you want to delete.
  The change an Account window will appear.
 iii) Click on Delete the Account.
  The Delete Account window will appear.
 iv) Click on anyone of the following options:
  Delete files: To delete all the files contained in the user account.
  Keep files: To keep users personal files contained in the user account.
  The confirm Deletion window will appear.
 v) Click on Delete Account
  The user account will be deleted.
 vi) The manage Accounts window will appear.
 vii) Click on close button.
 6. Following are the steps to share information:
 i) Open the folder that contains the documents you want to share.
 ii) Click on the document you want to share.
 iii) Click on the down arrow of share with.
  A drop down list of menu will appear.
 iv) Click on Specific People.
  File sharing dialog box will appear.
 v) Click on the down arrow button to open the menu.
 vi) Click on the username with whom you want to share the document.
 vii) Click on Add.
  The user is added to the list.
 viii) Click on the down arrow of the user name
 ix) Click on anyone of the following Permission levels:

→
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  Read: User can only read the document.
  Read/write: User can read and make changes in the document.
 x) Click on share.
  A message will be displayed 'your folder is shared'.
  The shared document will be displayed.
 xi) Click on Done.
CO-SCHOLASTIC TASK
A. This type of operating system is mostly used by people on their desktop and laptop 
computers today. Microsoft window and Apple MacIOS platforms are both examples 
of operating systems that will let a single user have several programs in operation at the 
same time.
B. Do yourself.
C. Do yourself.

Chapter 2
SCHOLASTIC TASK
A. 1. (c) 2. (c) 3. (b) 4. (c)
B. 🄱 : Bold. It is used to give bold effect to the data.
 🄸 : Italic. It is used to Italicise the data.
 🅄 : Underline. It is used to underline the data.

  : Left Alignment. It is used to left align the data.

  : Center Alignment. It is used to center align the data.

  : Right Alignment. It is used to right align the data.

C. 1. Cell (s) 2. Home tab 3. Font button 4. is immediately applied.
D. 1. T 2. F 3. T 4. T 5. T
E. 1. Following are the steps to change the font colour of the data:
 i) Select the cell (s) which contain the data whose font colour you want to change.
 ii) Click on Home tab.
 iii) Click on the down arrow of the Font colour button.
  A drop down list of font colours will appear.
 iv) Select the colour you want to display by clicking on it.
  The data immediately changes to the new font colour.
Following are the steps to change the allignment of the data:
 1. Select the cell(s) which contains the data you want to align.
 2. Click on the Home tab.
 3. Click on any one of the following buttons to align to the:

  : Left

  : Center

  : Right

  The data is aligned to your selected choice.
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 2. There are various formats in Microsoft Excel 2010. Some of them are discussed 
below:

 General : General format cells have no specific number formats.
 Number : Number format is used to display numbers generally.
 Currency : Currency format is used for general monetary values.
 Accounting : Accounting format lines up the currency symbols and decimal 

points entered in a column.
 Date : Date format displays the date formats. It begins with an asterisk (*)
 Time : Time format displays the time formats. It also begins with an 

asterisk (*).
 Percentage : Percentage format multiplies the cell value by 100 and displays the 

result with a percent symbol.
 Text : Text format treats the number entered as a text. The cell is dis-

played exactly as the data is entered.
 3. Following are the steps to change number format in a worksheet:
 i) Select the cell(s) which contains the data you want to format.
 ii) Click on the Home tab.
 iii) Click on the down arrow of the number formats.
  A drop down list of number styles will appear.
 iv) Click on any one of the number format.
 v) Click on More Number Format to see all the categories of number formats.
  The formal cells dialog box will appear.
 vi) Click on the Number tab.
 vii) Click on the Number category which you want to select.
 viii) Click on Ok.
  The number formatting will be applied to the data.
 4. Following are the steps to add background to the worksheet:
 i) Click on the page Layout tab.
 ii) Click on the Background button. The sheet Background dialog box will appear.
 iii) Select the folder from where you want to select an image to apply it as a back-

ground.
 iv) Click on the image.
 v) Click on Insert
  The selected image will be applied as the background of the worksheet.
CO-SCHOLASTIC TASK
A. Do yourself.
B. Do yourself.

Chapter 3
SCHOLASTIC TASK
A. 1. (b) 2. (c) 3. (a) 4. (a) 5. (c)
B. 1. Column : This type of chart displays columns of various lengths vertically.
 2. Area : This type of chart represents change over time but emphasises the 

individual contribution of each data part.
 3. Doughnut : This type of chart compares multiple series of data.
 4. Radar : This type of chart depicts seperate axis for each data category radiat-

ing out from the center.
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 5. Surface : This type of chart represents the interaction of three sets of data.
 6. Stock : This type of chart helps in tracking stock market activity.
 7. Bubble : This type of chart uses three columns of data. Each data point indi-

cates a third dimension.
C. 1. Chart is a representation of data. It represents data in the form of lines, curves etc. 

Data represented in the form of charts looks more presentable and is widely used 
for conveying numbers to the management in big corporate offices.

 2. Following are the steps to create a chart in a worksheet:
 i) Select the data which you want to represent on a chart.
 ii) Click on the Insert tab.
 iii) Click on the chart type you want to use.
  A drop down list of charts will appear.
 iv) Click on the chart style you want to use.
  The chart will be created and displayed on the worksheet.
 3. There are 11 different types of charts available in Microsoft Excel 2010. Some of 

them are:
  Line, Pie, column, Bar surface, Area, Doughnut, Radar, Scatter, Bubble, Stock.
 4. Following are the steps to change the style of chart:
 i) Click on an empty area of the chart.
 ii) Click on Design tab.
 iii) Click on the new chart style you want to use.
 iv) Click on the down arrow to see more styles.
  The style of the chart will change and display the new chart style will be dis-

played.
 5. Following are the steps to change the type of chart:
 i) Click on an empty area of the chart.
 ii) Click on the Design tab.
 iii) Click on change chart Type.
  The change chart type dialog box will appear.
 iv) Click on the new chart type you want to use.
 v) Click on the chart style.
 vi) Click on Ok.
  The chart type will change and will be displayed.
 6. Following are the steps to add axis title to the chart:
 i) Open the chart to which you want to add the title.
 ii) Click on the Layout tab.
 iii) Click on the Axis Titles button. 
  A dropdown list will appear.
 iv) Click on any one axis where you want to add the title.
 v) Click on Title Below Axis.
  The title will add to the chart.
 vi) Click in the place holder text box to add text to the axis.
  Similarly you can add title to the other axis also by repeating the previous steps.
 7. Sometimes, there is less or more space on the worksheet. In this case, you can 

resize the chart.
  Following are the steps to resize the chart:
 i) Click on the empty area of the chart. The handle will appear in the corner of the chart.



23 Windows Magic 

 ii) Take mouse pointer over the handle, the mouse pointer changes to ↔.
 iii) Click on ↔and drag the handle inward and outward to resize the chart.
 iv) Release the mouse button as you reach the desired size.
 8. We wove a chart in order to change its location. Following are the steps to move 

the chart:
 i) Click on an empty area of the chart.
  The chart will surrounded with the handle.
 ii) Move the mouse pointer over the edge of the chart until the mouse pointer chang-

es to ↔

↔

.
 iii) Click and drag the char to the new location.
 iv) Release the mouse button. The chart will move to a new place.
CO-SCHOLASTIC TASK
A. Do yourself.
B. Do yourself.
C. Surface, Area, Doughnut, Pie, Line.

Chapter 4
SCHOLASTIC TASK
A. 1. (c) 2. (b) 3. (d) 4. (a) 5. (d) 6. (c)
B. 1. T 2. F 3. F 4. T 5. T
C. 1. Microsoft Access 2010 is a database Program. It is used to create database that 

can store large amount of information. You can create, manage and retrieve large 
collection of information.

  Microsoft Access creates relational databases containing multiple tables which are 
linked to each other.

  Following are the steps to start Microsoft Access 2010:
 i) Click on the start button.
  The start menu will appear.
 ii) Click on All Programs.
  The Programs list will appear.
 iii) Click on Microsoft Office.
 iv) Click on Microsoft Access 2010.
  Microsoft Access 2010 window will appear.
 2. Following are the components of Microsoft Access 2010 window:
 Quick Access Toolbar : It displays the quick access buttons like save, undo and 

Redo.
 Title Bar : It displays the name of the database on the title bar.
 File tab : It displays a list of various menu commands like New, 

Save, Open, Print, Exit etc.
 Tab : It displays various tabs like Home tab, create tab, Exter-

nal Data Tab, etc.
 Ribbon : It displays various commands that are under various 

tabs.
 Object Tab : It provides access to all the opened database objects 

such as tables forms, reports, etc.
 Navigation Pane : It shows a list of all the available database objects.
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 Status Bar : It displays the information about the current object.
 Record selector : It displays the current record number and helps to navi-

gate to other records.
 View Buttons : It enables you to switch between various views of the 

selected object.
 3. Microsoft Access 2010 database contains the following:
  Tables:
  Microsoft Access 2010 database consists of collection of tables that are organised 

in rows and columns.
  Record:
  A row in a table is known as a record. A record contains information about a given 

person, product or an event.
  Field:
  A column in a table is called a field. It is the smallest unit of data information and 

contains a specific piece of information within a record.
  Datasheet:
  Each table that appears as a spreadsheet grid is called a datasheet. We directly type 

in the datasheet.
  Filter:
  Filter is used to show only certain records and fields in the table.
  Query:
  Query is like a saved filter. It enables you to combine the data from multiple relat-

ed tables into a single datasheet of results.
  Reports:
  Reports are used to display data from tables and queries in a beautiful and an 

attractive manner. Reports contain title headers, footers, graphics, etc.
 4. Following are the steps to create database using templates:
 i) Open Microsoft Access 2010.
  The Backstage view will appear.
 ii) Click on the sample Templates.
  The available templates will appear.
 iii) Click on the template you want to select for your database.
 iv) Type a name for the database.
  By default the file Name will appear as Template Name 1. For eg. Students 1.
 v) Click on create.
  Now, Microsoft Access 2010 will automatically Prepare a new database for you.
 5. Following are the steps to enter data in a template:
 i) You will see a security warning some active content has been disabled. When you 

open a template.
 ii) Click on Enable content.
  Now, you can start entering data in the database.
 iii) Click on New
  Student Details dialog box will appear.
  Enter the required data in the fields from the keyboard.
 iv) Click on Save and New to fill another students detail.
 v) After all the details of every students are filled, click on close.
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  Now, your entered data appears on your datesheet.
  As you complete entering a data into your datesheet, you need to save it.
 vi) Click on the File tab.
  The Backstage view will appear.
 vii) Click on Save.
  Now, the data is saved.
 6. Following are the steps to open a Database of Microsoft Access 2010.
 i) Open Microsoft Access 2010.
 ii) Click on the File tab.
  The Backstage view will appear.
 iii) Click on open.
  The Open dialog box will appear.
 iv) Click here to view the folder where the database is saved.
 v) Click on the name of the database which you want to open.
  The name of the database will appear in the file name textbox.
 vi) Click on Open
  The database file will open.
 vii) A security alert bar will appear, click on Enable content.
  The database file will open.
CO-SCHOLASTIC TASK
A. Do yourself.
B. Do yourself.

Assessment A
A. Multitasking is a type of operating system which is mostly used by people on their 
desktop and laptop computers today.

Microsoft's Windows and Apple's MacIOS platforms are both examples of operat-
ing systems that will let a single user have served programs in operation at the same time.
B. 1. Do yourself
 2. Do yourself

Assessment B
A. 1. Doughnut Chart 2. Scatter Chart 3. Surface Chart 4. Bubble Chart
B. Do yourself
C. Do yourself

Test Paper A
A. 1. (c) 2. (c) 3. (b) 4. (c) 5. (c) 6. (a)
B. 1. Single user 2. Multitasking 3. User 4. Share
C. 🄱 : Bold icon. It is used to make the data bold.
 🄸 : Italic icon. It is used to Italicize the data.
 🅄 : Underline icon. It is used to underline the data.

  : Left Alignment. It is used to left align the data.

  : Center Alignment. It is used to center align the data.

  : Right Alignment. It is used to right align the data.
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D. 1. Column: This type of chart displays columns of various lengths vertically.
 2. Area: This type of chart represents changes over time but emphasises the individ-

ual contribution of each data part.
 3. Doughnut: This type of chart compares multiple series of data.
 4. Radar: This type of chart depicts seperate axis for each data category radiating out 

from the center.
 5. Surface: This type of chart represents the interaction of three sets of data.
E. 1. Following are the steps to change the user account picture:
 i) Open the Manage Accounts window from Control Panel.
 ii) Click on the user account whose Picture you want to change.
  The user Accounts window will appear.
 iii) Click on change your picture.
  Then choose your picture window will appear.
  A list of pictures will appear.
 iv) Click on the picture you want to use for the user account.
 v) Click on change picture.
  The User Accounts Window will appear displaying the new account picture.
  Click on the close button.
 2. Following are the steps to change number format in a worksheet:
 i) Select the cell(s) which contains the data you want to format.
 ii) Click on the Hometab.
 iii) Click on the down arrow of the Number formats.
  A drop down list of number styles will appear.
 iv) Click on any one of the number format.
 v) Click on More Number Formats to see all the categories of number formats.
  The format cells dialog box will appear.
 vi) Click on the Number tab.
 vii) Click on the number category which you want to select.
 viii) Click on Ok.
  The number formatting will be applied to the data.
 3. Sometimes, there is less space on the worksheet. In this case, you can resize the 

chart.
  Following are the steps to resize the chart:
 i) Click on the empty area of the chart. The handle will appear in the corner of the chart.
 ii) Take mouse pointer over the handle, the mouse pointer changes to ↔.
 iii) Click on ↔and drag the handle inward or outward to resize the chart.
 iv) Release the mouse button as you reach the desired size.
 4. Following are the steps to add background to the worksheet:
 i) Click on the Page Layout tab.
 ii) Click on the Background button.
  The sheet Background dialog box will appear.
 iii) Select the folder from where you want to select an image to apply it as a back-

ground.
 iv) Click on the image.
 v) Click on Insert.
  The selected image will be applied as the bacground of the worksheet.
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Chapter 5
SCHOLASTIC TASK
A. 1. (a), (b) 2. (a) 3. (c) 4. (d) 5. (d) 6. (b) 7. (b)
B. 1.  .html or .htm 2. HTML Tags 3. tags 4. slash(/) 5. Web browser
C. Certain tags form the basic structure form the basic structure of the web page.
 By using various HTML tags we can create a web page. The code is typed in a text 

editor like Notepad.
 HTML Tag
 1. Open Notepad from the Accessories menu.
 2. Type <HTML> in the beginning.
 3. Now type the text.
 4. Type </HTML> after all the text is typed.
  HTML tag declars the text as HTML.
  HEAD Tags.
 1. Type <HEAD> after the <HTML> tag.
 2. Press the Enter key twice.
 3. Type </HEAD>
  HEAD tag displays the title and heading for the web page.
  TITLE Tag
 1. Type <TITLE> below the <HEAD> tag.
 2. Type a title for your web page.
 3. Type </TITLE> after the title and before the </HEAD> tag.
  The title typed between the TITLE tags is displayed on the title bar of the browser.
  BODY Tag
 1. Type <BODY> below the </HEAD> tag.
 2. You can type all the text.
 3. Type </BODY> before the </HTML> tag.
  The body tag contains the body of the web page containing all the information to 

be displayed on the web page.
D. 1. HTML Tag: HTML tag declares the text as HTML.
 2. HEAD Tag: HEAD tag displays the title and heading for the web page.
 3. TITLE Tag: The title typed between the TITLE tag is displayed on the title bar of 

the browser.
 4. BODY Tag: The Body tag contains the body of the web page containing all the 

information to be displayed on the web page.
E. 1. Follow these steps to start creating web pages:
 i) Plan the Web Page: Firstly, select a topic or theme for the web pages. Then decide 

the type of information that is to be displayed in the web pages.
 ii) Gather Information: After Planning the web pages, you should gather all the 

information that is needed for the web pages like text, images, graphics, etc.
 iii) Organise Information: After all the information is gathered, it must be organised 

in different parts. Each part should contain enough information about the concept.
 iv) Enter Text: Now it's the time to type the text in a text editor or Word Processor. 

Each page is a separate document and HTML tags added to it make them web 
pages.
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  Add Images: The web pages can be made attractive by adding graphics.
  Add Hyperlinks: Hyperlink is a link between various web pages. It is used to 

connect various web pages.
  Publish web pages: When all the web pages are created, it's time to transfer them 

on a computer that makes them available on the web.
 2. Certain tags form the basic structure of the web page. They are discussed below:
  HTML Tag: <HTML> and </HTML> are the main tags which appear at the be-

ginning and ending of every text document.
  HEAD Tag: <HEAD> and </HEAD> are the document header tags which are im-

mediately used after the <HTML> tag. They contain the heading of the web page.
  TITLE Tag: <TITLE> and </TITLE> are the tags that define the title of the page. 

They appear next to the document header tag. They are contained in the HEAD TAG.
  BODY Tag: <BODY> and </BODY> tags include the body of the document. All 

the information, graphics, etc. in the HTML document are contained in this tag.
 3. Steps to save a web page:
 i) Click on File.
 ii) Click on Save or Save As.
  A drop down list of menu will appear.
  The Save As dialog box will appear.
 iii) Type a name for your web page in File name text box followed by .htm or .html.
 iv) Click on Save as type box to see the list of options by which you can save your 

web page.
 v) Click on Text Documents.
 vi) Click on Save.
  Now, the Notepad document is saved as HTML web page.
 vii) Double-click on the HTML web page to view it in a web browser.
 4. Following are the steps to create a number list.
 i) Type <OL> before the list.
 ii) Type <LI> infront of each item in the list.
 iii) Type </OL> after the list.
  The ordered list is displayed in the web browser.
 5. You can change the style of the numbered list. For example you can use 

A,B.C,D...... or i,ii,iii,iv, etc.
 i) Type <OL> before the list.
 ii) Type any one of the following:
  Type = "A" for A,B........
  Type = "a" for a,b........
  Type = "I" for I,II........
  Type = "1" for 1,2........
 iii) Type <LI> infront of each item in the list.
 iv) Type </OL> after the list.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do youself
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Chapter 6
SCHOLASTIC TASK
A. 1. (b) 2. (c) 3. (a) 4. (d) 5. (c)
B. 1. T 2.F 3. T 4. T 5. T
C. 1. Line colour
  Click to display a palette of colours for lines.
 2. Fill colour
  Click to display a palette of colours for fills.
 3. (a) Black and white
  Changes the line colour to black and the fill colour to white.
  (b) No outline
  Used to draw shapes without outlines or borders.
  (c) Toggle colour
  Switches the line colour to the fill colour and vice-versa.
D. 1. Label Text: In this when you type text, it does not wrap. The box keeps on ex-

panding.
 2. Block Text: In this you select a width for the box. Hence, it wraps text.
E. 1. The Timeline contains various frames, layers and scenes that make up a movie. 

You can use the Timeline to organise and control the movies.
  Current scene
  Displays the name of the scene on which you are currently working.
  Layers
  Use layers to organise artwork, animation, sound and interactive elements. Layers 

enable you to keep pieces of artwork seperate and combine them to form a merged 
image, such as a company logo that includes a layer of text and another layer with 
a graphic shape.

 2. The Drawing toolbar is packed with tools that you can use to create and work with 
graphical objects.

  Subselect : Displays edit points you can adjust to change a lline.
  Arrow : Used to select and move items on the stage.
  Free transform Tool : Used to transform graphic objects.
  Line : Draws Straight
  Pen : Used to draw Precise curves.
  Oval : Draws circular and oval shapes.
  Pencil : Used to draw freedom lines.
  Ink Bottle : Used to change the style thickness and colour of lines.
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  Dropper : Used to copy the attributes of one object to another.
  Eraser : Eraser Parts of the graphic objects.
  Paint Bucket : Fills shapes or lines with colour.
  Brush : Draws with a fill colour, like Paintbrush.
  Rectangle : Draws square and rectangular shapes.
  Text : Draws text boxes.
  Lasso : Used to select irregularly shaped objects on the stage.
  Gradient Transform Tool : Used to change gradient shape.
 3. There are several types of layers in Macromedia Flash.
  They are:
  Plain Layers: Used to display graphics, sound and movie clips.
  Guide Layers: In this, those objects are placed which are used or other layers.
  Mask Layers: In this, you can hide elements in other layers from visibility.
  Following are the steps to add layers:
 i) Click on the layer which will appear below the new layer.
 ii) Click on Insert Layer icon.
 iii) A new layer will appear immediately.
  Now you can make any object or shape in this layer.
 4. Following are the steps to set layer properties:
 i) Click on the layer for which you want to set properties.
 ii) Click on Modify menu. The modify menu will appear.
 iii) Click on Timeline.
 iv) Click on Layer Properties.
 v) Type a name for the layer in the Name text box.
 vi) Change the desired layer property:
   To make the layer visible, click on show checkbox.
   To lock the layer to prevent accidental changes, you can click on the Lock 

check box.
 vii) You can select a layer type.
 viii) Click Ok.
 5. Following are the steps to set movie dimensions and speed for animation:
 i) Click on Modify in the menu bar.
 ii) Click on Document.
  The Document Properties dialog box will appear.
 iii) Type a title name for your document.
 iv) Select the measurement unit (e.g. Pixel) from the Ruler Unit list box.
 v) Type a value for the width of the movie in the width text box.
 vi) Type a value for the height of the movie in the Height text box.
  The minimum size you can set for a Flash movie is 18 Pixels height and the maxi-

mum size can be 2880 Pixels width and 2880 Pixels height.
 vii) Type the number of frames per second you want to movie to play in Frame Rate 

text box.
 viii) Click on Ok.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do youself
C. Do youself
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Chapter 7
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (d) 4. (b)
B. 1. Virus 2. badly 3. Trojan Horse 4. File Infector 5? Boot Sector. 
C. 1. Trojan Horse: Trojan Horse is a virus that comes as if it is a friendly Program. 

But if it is downloaded on your computer, it destroys all your data. It comes when 
we download a game from the internet.

 2. File Infector: This virus adds a virus code to the regular Programming code with-
in Program files. It is the most common type of virus. When the regular infected 
Program files run on the computer, other program files also get infected.

 3. Boot-Sector virus: This virus attaches itself to the boot-sector of the desk. 
Boot-Sector is the part of the disk where all the start-up instructions are kept. This 
dangerous virus destroys this sector which is loaded into the memory everytime 
the disk is booted.

 4. Worm: Worm is not as harmful as Trojan Horse Virus. It is a virus that simply rep-
licates itself. This virus has the capacity to travel from one computer system to an-
other. Though it does not affect the system immediately, but in the long run it takes 
over all the computer system resources. Hence, the computer become useless.

D. 1. A virus is a program that can affect our computer badly. It also destroys all the data 
stored in it. If a virus attacks the computer, the computer operating system may get 
damaged.

 2. The various types of virus are:
 i) Trojan Horse
 ii) Boot-sector virus
 iii) File-Infector
 iv) Worm
 v) E-mail virus.
 3. Following are the steps to scan a file with antivirus:
 i) Open the folder which contains the file. Right-click on the file.
  A drop down menu list will open.
 ii) Click on Quick Heal Antivirus Pro Scan.
 iii) The scanning will start.
  After scanning the message will be displayed whether the file is infected or not.
 4. You should protect your computer from virus by the following steps:
  Make a back up of all the important files in the computer.
  Always check the files in the computer that come from an unknown source.
  Always install a good antivirus Program in the computer.
 5. Virus creators have added new tricks to their bag throughout the years. One such 

trick is the ability to load viruses into memory so that they can keep running in the 
background as long as the computer remains on. This gives viruses a much more 
effective way to replicate themselves. Another trick is the ability to infect the boot 
sector on floppy disks and hard disks.

  The boot sector is a small program which is the first part of the operating system 
that the computer loads. By putting its code in the boot sector, a virus can gurantee 
its execution. It can load itself into the memory and run whenever the computer is 
on:
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CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself

Assessment C
A. 1. Do yourself
 2. Do yourself
B. Microsoft Access 2010 is a database Program. It is used to create databases that can 
store large amount of information. You can create, manage and retrieve large collection 
of information. Microsoft Access creates relational databases containing multiple tables 
which are linked to each other.

Assessment D
A. Macromedia Flash is a multimedia software designed to create animation, multime-
dia and web page components. It also enables you to make video over the internet you 
might have received many greeting cards through email, they are all made in Macromedia 
Flash.
B. Do yourself
C. Do yourself

Test Paper B
A. 1. (b)  2. (c)  3. (d) 4. (b) 5. (a)
B. By using various HTML tags, we can create a web page.
 HTML Tags
 1. Open Notepad from the Accessories menu.
 2. Type <HTML> in the beginning.
 3. Now type the text.
 4. Type </HTML> after all the text is typed.
HTML tag declares the text as HTML.
 HEAD Tags
 1. Type <HEAD> after the <HTML> tag.
 2. Press the Enter key twice.
 3. Type </HEAD>.
  HEAD tag displays the title and heading for the web page.
 TITLE Tag:
 1. Type <TITLE> below the <HEAD> tag.
 2. Type a title for your web page.
 3. Type </TITLE> after the title and before the </HEAD> tag. The title typed be-

tween the TITLE tags is displayed on the title bar of the browser.
 BODY Tag:
 1. Type <BODY> below the </HEAD> tag.
 2. You can type all the text.
 3. Type </BODY> before the </HTML> tag.
  The body tag contains the body of the web page containing all the information to 

be displayed on the web page.
C. 1. HTML Tag: <HTML> and </HTML> are the main tags which appear at the be-

ginning and ending of every text document.
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 2. HEAD Tag: <HEAD> and </HEAD> are the document header tags which are im-
mediately used after the<HTML> tag. They contain the heading of the web page.

 3. TITLE Tag: <TITLE> and </TITLE> are the tags that define the title of the page.
They appear next to the document header tag. They are contained in the HEAD 
tag.

 4. BODY Tag: <BODY> and </BODY> tags include the body of the document. All 
the information, graphics, etc. in the HTML document are contained in this tag.

D. 1. T 2. F 3. T 4. T 5. T
E. 1. Boot-Sector virus: This virus attaches itself to the boot-sector of the disk. 

Boot-sector is the part of the disk where all the start-up instructions are kept. This 
dangerous virus destroys this sector which is loaded into the memory every time 
the disk is booted.

 2. Worm: Worm is not as harmful as Trojan Horse Virus. It is a virus that simply 
replicates itself. This virus has the capacity to travel from one computer system 
to another. Though it does not affect the system immediately, but in the long run 
it takes over all the computer system resources. Hence, the computer becomes 
useless.

F. 1. Following are the steps to create a database using templates:
 i) Open Microsoft Access 2010 
  The Backstage view will appear.
 ii) Click on the Sample templates.
  The available templates will appear.
 iii) Click on the template you want to select for your database.
 iv) Type a name for the database. By default the File Name will appear as Template 

Name 1 For e.g. Students 1.
 v) Click on create.
  Now, Microsoft Access 2010 will automatically prepare a new database for you.
 2. Following are the steps to create a numbered list:
 i) Type <OL> before the list.
 ii) Type <LI>  in front of each item in the list.
 iii) Type </OL> after the list.
  The ordered list is displayed in the web browser.
  We can also change the style of the ordered list for example you can use A,B,C,D 

or i,ii,iii,iv, etc.
 1. Type <OL> before the list.
 2. Type any one of the following 
  TYPE = "A" for A,B .........
  TYPE = "a" for a,b ............
  TYPE = "I" for I,II ............
  TYPE = "1" for 1,2 
 3. Type <LI> in front of each item in the list.
 4. Type </OL> after the list.
 3. Following are the steps to set layer properties:
 i) Click on the layer for which you want to set up properties.
 ii) Click on Modify menu. The Modify menu will appear.
 iii) Click on Timeline.
 iv) Click on Layer Properties.
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 v) Type a name for the layer in the Name text box.
 vi) Change the desired layer Property:
  To make the layer visible, click on show checkbox.
  To lock the layer to prevent accidental changes, you can click on the Lock 

checkbox.
 vii) You can select a layer type.
 viii) Click on Ok.
 4. There are several types of layers in Macromedia Flash. They are:
  Plain Layers: Used to display graphics, sound and movie clips.
  Guide Layers: In this, those objects are placed which are used on other layers.
  Mask Layers: In this you can hide elements in other layers from visibility.
  Following are the steps to add layers:
 i) Click on the layer which will appear below the new layer.
 ii) Click on Insert Layer icon.
  A new layer will appear immediately.
  Now, you can make any object or shape in this layer.
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Class VIII
Chapter 1

SCHOLASTIC TASK
A. 1. (d) 2. (b) 3. (a) 4. (a) 5. (b) 6. (d)
B. 1. T 2. T 3. T 4. T 5. 
C. 1. 350 RAM AC 2. Virus 3. Fragmented 4. Antivirus 5. antivirus.
D.

Virus Antivirus
1. Virus is a program that damages the 

computer deliberately and badly af-
fects the computer.

2. It damages all the files and storage 
devices attached to the computer.

1. Antivirus is a software which is de-
veloped to protect the computer from 
viruses.

2. It is important to install an antivirus 
in the computer as it identifies and 
removes the deadly viruses found in 
the computer.

E. 1. Hard Disk Drive is a part of the computer hardware. It is a storage device or sec-
ondary storage device or secondary storage devices also known by different names 
such as magnetic disk, HD Drive, Fixed Disk, non-volatile memory. 

 2. Fragmentation helps to store parts of file at many different location.
  Defragmentation helps to place all the parts of a file at one location taking less 

time to search the file from the hard drive.
 3. Follow the given tips before you install an antivirus:
  Verify that the computer is not infected with a virus.
  Uninstall any other antivirus program that is installed in the computer.
  Delete all the files in the Windows Temporary folder.
  Check the available hard disk space for antivirus.
  Close all the Programs before starting the installation of the antivirus.
 4. Some basic tips that can be followed to take care of the hard disk are given as 

follows:
 i) Always make sure that the hard disk is mounted properly.
 ii) Check whether the power source cable and cable connection are properly installed 

on the computer or not.
 iii) Run the BIOS set-up to see. If the hard-disk is detected by the computer or not.
 iv) Don't ignore if the computer screen displays an error message during start-up.
 v) Never press the escape key without reading the error message displayed on the 

computer screen.
 vi) Update the antivirus from time-to-time.
 vii) Run scandisk and defragment the hard disk frequently.
 5. There are many ways through which a computer can get infected with a virus. 

Some of them are:
 i) Opening E-mail Attachments:
  If you open an e-mail attachment infected with a virus, the computer will also get 

infected with the virus.
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 ii) Accepting without Reading:
  If the user accepts any message without reading, the computer may get infected 

with virus.
 iii) Downloading without Internet:
  When we download songs, videos, games, software etc from the Internet the com-

puter gets a virus.
 iv) Not Running the latest updates:
  All the updates associated with Microsoft Windows are necessary to update for not 

running of windows.
 v) No Antivirus:
  Your computer may be at risk if no antivirus is installed in it.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself
C. It is important to install an antivirus in the computer as it identifies and removes the 
deadly viruses found in the computer. Antiviruses also warns us if any external storage 
device infected with virus is being attached to the computer.

Chapter 2
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (c) 4. (d)
B.

Primary Memory Secondary Memory
1. It is fast.
2. It is expensive.
3. It has low capacity.
4. It connects directly to the processor.

1. It is slow.
2. It is cheap.
3. It has large capacity.
4. It is not connected directly to the 

processor.

C. 1. RAM: RAM stands for Random Access Memory. RAM is much faster to read 
from and write to than other kinds of storage in a computer.

 2. ROM: ROM stands for Read Only Memory. It is the computer memory in which 
the data has been pre-recorded.

 3. WORM: WORM stands for write-once, read many. These optical discs can be 
recorded by the user only once but cannot be erased.

 4. Optical Disc: Optical Disc is an electronic data storage medium from which data 
is read and written to by using a low-powered laser beam.

D. 1. Byte : One character.
 2. Kilobyte : 1000 Bytes.
 3. Megabyte : 1,048,576 characters.
 4. Terabyte : 1,099,511,627,77 characters.
 5. Gigabyte : 1,073,741,824 characters.
E. 1. One byte is equal to one character. A character can be a number, letter or symbol. 

One byte consists of eight bits (binary digits). A bit is the smallest unit of informa-
tion a computer can process.

 2. A volatile memory loses all its contents when the power of the computer is turned 
off.
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 3. Non-volatile memory does not lose its contents when the power of the computer is 
turned off.

 4. Computer memory is the form of an electronic storage which works very fast. If 
the CPU of the computer had to constantly access the hard drive to retrieve each 
and every data it needs, it would operate very slowly. If the information is kept in 
the memory, the CPU can access it very quickly.

 5. There are two types of Primary Memory: They are RAM and ROM.
  RAM: RAM stands for Random Access Memory. It is a place in a computer where 

the operating system, application program and data which are in current use are kept 
so that they can be quickly read and processed by the processor of the computer.

  ROM: ROM stands for Read Only Memory. It is the computer memory in which 
the data has been pre-recorded.

CO-SCHOLASTIC TASK
A. Do yourself
B. Computer memory is the form of an electronic storage which works very fast. If the 
CPU of the computer had to constantly access the hard drive to retreive each and every 
data it needs, it would operate very slowly. If the information is kept in the memory, the 
CPU can access it very quickly.
C. Temporary Storage Areas, Permanent Storage Areas
D. 

Chapter 3
SCHOLASTIC TASK
A. 1. (c) 2. (c) 3. (a) 4. (b) 5. (c) 6. (d)
B. 1. Text : Text data type is used to enter text and numbers in the field. It 

can store up to 255 characters.
 2. Memo : Memo data type can store up to 65,535 characters.
 3. Date/Time : Date/Time data type contains numbers that represent date and 

time.
 4. Auto Number : Auto Number type automatically stores the numbering for each 

record.
 5. Yes/No : Yes/No data type contains boolean data.
 6. Attachment : Attachment data type is used to attach data files from word pro-

cessing, graphics programs etc.
C. 1. relational 2. Access tables 3. datesheet 4. Primary 5. Properties.

Memory Chips
RAM is a type of memory  
chip that makes up the 
main memory in many 
computer systems.

Memory Mod-
ule
A memory 
module is a cir-
cuit board that 
holds memory 
chips.
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D. 1. A database is a collection of information that is organised in a way so that it can be 
easily accessed, managed and also updated. 

 2. A key which differentiates the records in a file is known as the Primary key.
 Following are the steps to set the Primary key:
 i) Select the field you want to set as the Primary key.
 ii) Click on the Primary key button.
  The Selected field is set as the primary key. A small key will be visible in the se-

lector column against the field name.
 3. Following are the steps to create a new table in Datasheet view.
 i) Click on the create tab.
 ii) Click on the Table button.
  A new table will be created.
 iii) Double-click on the column header to enter the name for the field.
 iv) Press the Enter key.
 v) Click on the next column to select the data type.
  A drop-down list of data will appear.
 vi) Select the data type.
 vii) Now, you can create more fields by repeating step 5 and step 6.
 4. Following are the steps to create a new table in Design view:
 i) Open Microsoft Access database.
 ii) Click on the create tab.
 iii) Click on the Table Design button.
 iv) Type the name of the first field in the Field Name Column.
 v) Press the Tab key to move to Data Type Field to enter the data type.
  A drop down list of menu will appear.
 vi) Select the data type you want for the field name
 vii) Press the Tab key to enter the description in the Description column.
 5. In the Datasheet view, the table is represented as a collection of columns and rows 

known as datasheet. Following are the steps to enter records in the table:
 i) Double-Click on the Table name in the Navigation pane.
 ii) Click on the First field name student ID.
 iii) Type the ID Number.
 iv) Press the Tab key to complete all the other enterprises.
 v) As you reach the last entry, press the Tab key to come again to the first field name 

in the second row.
 vi) Complete the datasheet by adding the remaining records by repeating step 2 to step 

5.
 vii) Click on the save button.
  The records will be saved in the table.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself
C. Properties Pane : Properties pane displays the various properties that appear at 

the bottom of the database pane.
 General Tab : General tab contains the general properties associated with 

the field.
 Lookup Tab : Lookup tab is used to set look-up lists.
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 Property Information : Property Information displays the information of each prop-
erty selected.

 Drop-down lists : Some properties have dropdown lists from which you can 
select various options.

 Yes/No properties : Some properties display Yes/No. These are the default val-
ues already filled.

Chapter 4
SCHOLASTIC TASK
A. 1. (c) 2. (a) 3. (d) 4. (b) 5. (d)
B. 1. T 2. F 3. F 4. T 5. T 6. T
C. 1. AND : AND Criterion filters the records where both the criterias are fulfilled.
  OR : OR criterion filters the records where at least one of the criteria is fulfilled.
 2. Following are the steps to filter data by selection:
 i) Click on the data you want to use to filter the records.
 ii) Click on the Home tab.
 iii) Click on selection.
 iv) Click on the criterion you want to use to filter the records.
  Now, Microsoft Access will only display the records that contain the filtered data.
  You will see the word filtered at the bottom of the access screen.
 v) Click on Toggle filter to display all the records.
 3. You can also filter the data by form. This feature enables you to filter multiple fields. 

You can combine the criteria using AND, OR, or a combination of AND and OR.
  Following are the steps to filter data using AND criteria.
 i) Open the table in Microsoft Access.
 ii) Click on the Home tab.
 iii) Click on the Advanced button.
 iv) Click on filter by form.
  The filter by form window will appear and will display an empty table.
 v) Click on the field you want to filter.
 vi) Click on the down arrow of the field to view the values.
 vii) Select any one value from the list.
  Now, the filtered record will appear.
 viii) Click on any other field and repeat the step 6 and step 7 to filter another field.
 ix) Click on the Toggle filter button.
  Now, only the two, AND combination filtered data will appear on the datasheet.
 4. Rename a Field.
  Following are the steps to change the name of the field:
 i) Right-click on the field, you want to rename.
  A list of menu will appear.
 ii) Click on Rename Field.
  The field name will be highlighted.
 iii) Enter a new name for the field.
 iv) Press the Enter key.
 v) Now the field is renamed.
  Delete a Field.
  Following are the steps to delete a field:
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 1. Right-click on the field you want to delete.
  A drop-down list of menu will appear.
 2. Click on Delete field
  A prompt box will appear.
 3. Click on Yes.
  Now the field will be deleted from the table.
  Add a Field.
  Following are the steps to add a field:
 i) Righ-click on the name of the field that you want to appear after the new field.
  A menu will appear.
 ii) Click on Insert Field.
  The new field will appear in the table as field 1.
  you can rename it and add information to it.
 5. A database in which there is a relation between tables is called Relational database. 

To create a relation between two tables, it is necessary to have a common field in 
them.

  Following are the steps to create relationship between table:
 i) Click on the Database Tools.
 ii) Click on the Relationships button.
  The Relationship window will appear.
  The show Table dialog box may also appear to list the table in the database.
 iii) If Show Table dialog box does not appear, click on the show Table button.
 iv) Click to select a table.
  You want to add a relationships.
 v) Click on Add.
 vi) Repeat step 3, step 4 and step 5 to add more tables to the relationships.
 vii) Click on close after all the tables are added.
  The Show Table dialog box will disappear.
  A box for each table will be displayed in the Relationships window.
  The Primary key for each table will be highlighted.
 viii) Point the mouse pointer over the field you want to create a relationship with anoth-

er table.
 ix) Drag the field to the other table untill a small box will appear over the matching 

field.
  The Edit Relationship dialog box will appear. The Table/Query and Related Table/

Query will display the names of the tables of relationship. At the bottom Relation-
ship type displays the type of relationship.

 x) Click on create.
  A line connecting the fields of the two tables will appear showing the created rela-

tionship.
CO-SCHOLASTIC TASK
A. A database in which there is a relation between tables is called Relational database. To 
create a relation between two tables, it is necessary to have a common field in them.
For example: A School's table contains field of student's name and the students table also 
contains field of student's name. Both the tables can be joined by this common field.
B. Do yourself.
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Assessment A
A. Do yourself
B. 1. RAM 2. Optical Disc 3. Hard Disk
C. 1. Fragmented Disk 2. Defragmented Disk

Assessment B
A. A database is a collection of information that is organised in a way so that it can be 
easily accessed, managed and also updated. The main database is the relational database 
which is used in the computer field.
B. Do yourself
C. Do yourself

Test Paper A
A. 1. (a) 2. (d) 3. (c) 4. (a) 5. (c)
B. 1. T 2. T 3. T 4. T 5. T
C.

Virus Antivirus
1. Virus is a program that enters the 

computer deliberatelly and badly 
affects it.

1. Antivirus is a software which is de-
veloped to protect the computer from 
viruses.

2. It damages all the files and storage 
devices attached to the computer.

2. It is important to install antivirus 
in the computer as it identifies and 
removes deadly viruses found in the 
computer.

D. 1. Byte : One character.
 2. Kilobyte : 1000 Bytes.
 3. Megabyte : 1,048,576 characters.
 4. Terabyte : 1,099,511,627,77 characters.
 5. Gigabyte : 1,073,741,824 characters.
E. 1. RAM: RAM stands for Random Access Memory. RAM is much faster to read 

from and write to than other kinds of storage in a computer.
 2. ROM: ROM stands for Read Only Memory. It is the computer memory in which 

the data has been pre-recorded.
F. 1. relational 2. Access tables 3. datesheet 4. Primary 5. Properties.
G. 1. It is important to install an antivirus in the computer as it identifies and removes 

the deadly viruses found in the computer. It also warns us if any external storage 
devices infected with virus is being attached to the computer.

  Following are the steps to install an antivirus:
 i) Open the folder where the Quick Heal Antivirus is stored.
 ii) Double-Click on the set-up file.
  The User Account Control dialog box will appear.
 iii) Click on yes to continue.
  The preparing Installation window will appear.
  Then the license Information window will appear.
 iv) Click on the check box of 1 Agree.
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 v) Click on Next.
  The Install location window will appear.
 vi) Click on Next.
  The installation will start.
  After the installation completes, the following window will appear.
 2. Secondary memory is not directly accessible to the CPU. Some storage devices 

like Floppy disk, hard disk etc. are needed to access the memory. In this type of 
memory, the programs and data are stored for long-run.

  Optical Disc Storage:
  It is an electronic data storage medium from which data is read and written by 

using a low-powered beam.
  The three types of optical disc are:
 i) Read-only optical discs.
 ii) WORM? White Once Read Many
 iii) Rewritable/Magneto-optic discs.
  Hard Disk Drive:
  It is the main, and usually largest data storage device in the computer.
 3. Following are the steps to enter records in datasheet view.
 i) Double-click on the Table name in the Navigation pane.
 ii) Click on the first field name student ID.
 iii) Type the ID Number.
 iv) Press the Tab key to complete all the other entries.
 v) As you reach the last entry, press the Tab key to come again to the first field name 

in the second row.
 vi) Complete the datasheet by adding the remaining records by repeating step 2 to step 5.
 vii) Click on save button. The records will be saved in the table.
 4. A database in which there is a relation between tables is called Relational database. 

To create a relation between two tables, it is necessary to have a common field in 
them.

  Following are the steps to create relationship between tables.
 i) Click on the Database Tools.
 ii) Click on the Relationships button.

  The Relationship window will appear.
  The show Table dialog box may also appear to list the table in the database.
 iii) If show Table dialog box does not appear, click on the show Table button.
 iv) Click to select a table you want to add to relationships.
 v) Click on Add.
 vi) Repeat Step 3, Step 4 and Step 5 to add more tables to the relationships.
 vii) Click on close after all the tables are added.
  The show table dialog box will disappear.
  A box of each table will be displayed in the Relationships window.
  The Primary key for each table will be highlighted.
 viii) Point the mouse pointer over the field you want to create a relationship with anoth-

er table.
 ix) Drag the field to the other table untill a small box will appear over the matching 

field.
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  The Edit Relationship dialog box will appear. The Table/Query and Related Table/
Query will display the names of the tables of relationship. At the bottom Relation-
ship Type displays the type of relationship.

 x) Click on create.
  Now, the relationship will be created.
  A line connecting the fields of the two tables will appear showing the created rela-

tionship.

Chapter 5
SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (d)
B. 1. Greater than : >
 2. Greater than or equal to : > =
 3. Less than or equal to : < =
 4. Not equal to : < >
C. 1. report 2. Microsoft Access 2010 3. query 4. Create and run a query 5. AND Criteri-
on, OR Criterion.
D. 1. Microsoft Access 2010 is a database management system which was the capability 

of answering questions asked by a user.
 2. Following are the steps to run a query:
 i) Click on the Run button.
 ii) The answer to the query will appear in the Datasheet view.
 iii) The name of the fields will appear on the screen.
 3. Following are the steps to create a query:
 i) Open Microsoft Database which you had created previously.
 ii) Click on create tab.
 iii) Click on Query Design.
  The show table dialog box will appear.
  All the tables in the database will be listed in the dialog box.
 iv) Click on the table that contains the information that you want to use in your query.
 v) Click on Add.
  A box will appear displaying the fields for the table you selected.
 vi) Repeat steps 4 and 5 to add each table for the query.
 vii) Click on close.
 viii) Double-click on a field which you want to include in your query.
  The selected field name and table name will be displayed.
 ix) Repeat step 8 to include each and every field which you want to include in your 

query.
 4. We can use a report to display data from a query and/or table in an appealing way. 

Report helps us to represent the data in an organised way. The report automatically 
includes all the fields of the table. The fields are displayed in the same manner as 
they are in the table.

  Following are the steps to create simple report using report tool.
 i) Open Microsoft Access database.
 ii) Click on the table or query on which you want to base the report.
 iii) Click on create tab.
 iv) Click on the Report option.
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  This report will be build and displayed in the Layout view.
  Following are the steps to save a report:
 i) Click on the file tab.
  The Backstage view will appear.
 ii) Click on Save.
  The Save As dialog box will appear.
 iii) Enter the report name.
 iv) Click on OK.
  The report will be saved.
 v) Click on close button.
  The report will be closed.
 5. Following are the steps to create a report using Report wizard:
 i) Click on the create tab.
 ii) Click on Report wizard.
  The Report wizard dialog box will open.
 iii) Click on the drop down arrow of the Table/Queries.
  A list of all the tables and queries will appear.
 iv) Click on the table or query containing the field on which you want to base the report.
 v) Under the headings Available Fields, double-click on each field that you want to 

included in the report.
  The selected fields will be listed below the headings selected Fields.
 vi) Click on Next.
 vii) You can group your data. Click on Next.
 viii) To sort records of the table, Click on the down arrow button of this area.
 ix) Click to select the field on which you want to use sort.
 x) Repeat step 7 and step 8 for other records.
 xi) Click on next.
 xii) Click on the radio button of the layout option to select the layout of the report.
 xiii) Click on the radio button of the orientation option to select the page orientation of 

the report.
 xiv) Click on Next.
 xv) Enter a name for the report.
 xvi) Click on Finish.
  The report will be created and displayed.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself

Chapter 6
SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (a) 4. (b) 5. (b)
B. 1. <HTML> tag
 2. <TITLE> tag
 3. <P> tag
 4. <U>
 5. <Font>
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 6. COLOR
 7. <H1>,<H2>,<H3>,<H4>,<H5>,<H6>
C. 1. T 2. F 3. T 4. F 5. T
D. 1. HTML stands for Hyper Text Markup Language. It is a markup language that is 

used for making web pages.
 2. We add a border to the image to make it took more attractive.
 3. You might have seen in newspapers, magazines, books etc that the image is sur-

rounded by text. This is known as wrapped text. The text is wrapped around the 
image to make it took more professional.

 4. Some of the HTML tags are 
  <HTML> tag : It is the main tag.
  <HEAD> tag : It contains the heading.
  <TITLE> tag : It contains the title of the web page that is displayed on the 

title bar.
  <Body> tag : It contains the content the content of web page.
  <BR> tag : It creates a new line.
  <P> tag : It starts a new paragraph.
  <B> : It makes the text bold.
  <I> : It makes the text italic.
  <U> : It underlines the text.
  <Font> : It changes the appearance of text.
  FACE : It changes the font of the text.
  SIZE : It changes the size of the text.
  Colour : It changes the colour of the text.
  <OL> : It creates an ordered list.
  <UL> : It creates an unordered list.
  <H1>,<H2>,<H3>, : It creates various heading levels.
  <H4>,<H5>,<H6>
 5. Following are the steps to center an image on the web page:
 i) Type <CENTER> before the IMG tag.
 ii) Type <CENTER> after the IMG tag.
  The image will appear in the center of the web page.
  Follow this step to add a border to the image:
 i) Type <IMG SRC = ''Picture name'' BORDER = 6> to add border to the image. The 

border is added to the image.
 6. Follow this steps to add alternative text:
  Type <IMG SRC = ''Picture name"
  ALT = "Image of computer" < to add alternative text
  Follow r\this step to wrap text around the image:
 i) Type < IMG SRC= "picture name" ALIGN = Left> to wrap text to the left side of 

the image.
  The text will be wrapped to the left side of the image.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself
C. Do yourself
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Chapter 7
SCHOLASTIC TASK
A.  1. (a) 2. (a), (b) 3. (d) 4. (d) 
B.  Following are the benefits of e-commerce:

 *  Reduced cost by reducing labour, reduced paper work, reduced errors in keying of in 
data, reduce post cost.

 *  Shorter lead times for payment and return on investment in advertising, faster deliv-
ery of product. 

 *  The ability to handle complex situation, product ranges and customer profiles with 
out the situation becoming unmanageable.

 *  Improved communication between trading partners leads to enhanced long term re-
lationships.

 *  The closer you are to your customer with them to change from normal business prac-
tices to best practice e-commerce it is harder for a competitor to upset your customer 
relationship.

 *  The Internet has the potential to expand your business in wider geographical loca-
tions.

C.

B2B E-commerce C2C E-commerce
1. Business to Business (B2B) E-Com-

merce describes commerce transac-
tions between a manufacturer and a 
wholesaler.

1. Customer to Customer (C2C)  E-com-
merce involves the transactions be-
tween consumers through some third 
party.

2. For example: A cloth manufacturer 
makes many B2B transactions like 
buying raw materials, machinery, etc.

2. For example: Now- a - days online 
auction of various products are being 
conducted. In this, a consumer posts an 
item for sale and other consumers bid 
to purchase that item.

B2C E-commerce C2E E-commerce
1. Business to Commerce (B2C) E-com-

merce sometimes also known as B2C 
describes the activities of business 
serving end consumer with goods or 
services..

1. Business to Employee (B2E) E- com-
merce uses an intra business network 
which allows various compares to 
provider goods or services to their 
employees.

2. For example: B2C will be a person that 
buys clothes or shoes from a retailer. 
So, this is B2C E-Commerce that as an 
exchange of product business and the 
consumer

2. B2E applications provided to employ-
ees include:

* Online insurance policy management.
* Online  supply request.
* Special employee offers
* Employee benefits reporting.

D. 
1. E- commerce stands for electronic commerce. E- commerce is the buying and sell-
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ing of products and services by business and consumers over the internet.
2. There are four basic models of e-commerce business.
 (1)  Business-to-Consumer   E-Commerce
 (2)  Business-to-Business    E-Commerce
 (3)  Customer-to-Customer   E-Commerce
 (4)  Business-to-Employee   E-Commerce

(1)  Business-to-Consumer E- Commerce: It is also known as B2C E-commerce and 
describes the activities of business serving end consumers with goods or ser-
vices.

(2) Business-to-Business E- Commerce: It is also known as B2B E-commerce and 
describes consumers transactions between a manufacturer and a wholesaler.

(3) Customer-to-Customer E- Commerce: It is also called C2C E-commerce and 
involves the transactions between consumer through some turd party.

(4) Business-to-Employee E- Commerce: Also known as  B2E e-commerce uses an 
intra business network which allows various compares to provide goods services 
to their employees.

3.  Some of the common shopping websites are:
  (1) Homeshop18.com
  (2) Futurebazaar.com
  (3) Snapdeal.com
  (4) Olx.com
4.  Following are the step given for the path of e-commerce transaction:
  (1) The customer searches for the product from the online shopping sites.
  (2) There a list of all the products is made in an electronic shopping chart.
  (3)   Then the customer enters a secure website which displays various payment  

        information.
  (4) The information about payment is sent to the bank for verification to the   

  E-retailer. 
  (5) E-retailer then sends a confirmation to the customer through its web server. 

Then the order comes in process.
  (6) Then the products are packed according to every order and transported forward 

for shipment.
  (7) The order is then carried to the courier company. All true shipment details are 

uploaded on the website.
  (8) Then the courier company takens the product to the customer.
  (9) At last, the products are delivered to the end customer. The customer gives a 

confirmation on receiving the product.
5. Following are the steps to shop online to buy a product:
  (1) Open Internet Explorer and type the address of any online shopping website.
    For e.g.:
    http://www.homeshop18.com
  (2) The home page of homeshop18 will appear in the internet explorer window.
  (3) Type the name of the product you want to buy in the search box.
  (4) Click on the search icon.
  (5) Your product will appear, read the features of the product.  
  (6) Click on buy now.
  (7) The user login page will appear. If you have an ID then enter your ID. If you 
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do not have ID then click on: No, I am a new user.  
  (8) Enter your email ID.
  (9) Enter a password.
 (10) Re-enter the password.
 (11) Click on SIGN UP.
 (12) The order information page will appear.
 (13) Enter your shipping address.
 (14) Click on SAVE & CONTINUE.
 (15) The mode of payment options will appear.
    Click on any one option.
 (16) Click on CONTINUE.
 (17) The confirm order page will appear. Click on CONFIRM ORDER.
    The order confirmation page will appear:
    You will get the updates of the order on your email ID and contact number.

CO-SCHOLASTIC TASK
1. {7}
 The courier company takes the product to the customer.
2. {4}
 The informational about payment is sent to the bank for verification.
3. {1}
 The consumer searches the product from the online shopping sites.
4. {8}
 At last the produce are delivered to the end customer.
5. {5}
 Products are packed according to every order and transported forward for   
 shipment.
6. {3}
 The customer enters a secure website which displays various payment    
 information.
7. {2}
 A list of all products is made in an electronic shopping cart.
8. {6}
 The order is then carried to the courier company

B. Do yourself
C. Do yourself

Chapter 8
A.  1. (d) 2. (d) 3. (b) 4. (a) 5. (c)   
B.

LAN (Local Area Network) MAN (Metropolitan Area Network)
1. It connects networking devices with 

in a short area.
1. It covers large span of physical area 

than LAN.
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2. It is commonly used network in small 
offices, homes, internet cafes etc.

2. This kind of network is hot mostly used 
but it has its own importance for some 
government bodies and organisations 
on a larger scale.

C. 
1. Router: It is specialised for determining the next networking point where the data 

packet is forwarded towards its destination.
2. Gateway: It is placed at the network node. Its function is to act as an interface with 

ther network that use protocols.
3. Bridge Networking Device: The bridge is used for connection of data link layer 

and multiple network segments.
4. Hub: A hub is a device used for connecting multiple twisted pair of fiber optic 

Ethernet devices together and making then act as a single network segment. 
D.  1. (b) 2. (c) 3. (a) 4. (d)  
E.  

1.  Networking is an interconnection of a group of computers linked together for the 
purpose of sharing data worldwide. 

2. A hub is a device used for connecting multiple twisted pair of fiber optic Ethernet 
devices together and making then act as a single network segment. 

3. Setup connection or network dialog box shows the following options: 
 *  Connect to the Internet.
 *  Set up a new network.
 *  Connect to a workplace.
 *  Set up dial up connection.
4. Given below are some of the which are used types of networks world wide.

1.  LAN (Local Area Network): It Connects Network devices within a short area  
i.e small offices, homes, internet cafes, etc.

2. WAN (Wide Are Network): As the word implies Wan covers a large distance 
for communication between computer. The internet itself is the biggest exam-
ple of WAN which covers the entire earth.

3. MAN (Metropolitan Area Network): This kind of network is not mostly used 
but it has its own importance for some government bodies and organisations 
on a larger scale.

5. Some of the computer networking components are:.
1.  Router: It is specialised for determining the next networking point where the 

data packet is forwarded to words its destination.
2. Gateway: It is placed at the network node. Its function is to act as an interface 

with outer network that uses protocols.
3. Bridge Networking Device: The bridge is used for connection of data link 

layer and multiple network segments.
4. Hub: A hub is a device used for connecting optic Ethernet devices together 

and making them act as a single network segment.
6. Following are the step to setup a network connection using Network and sharing 

center in windows 7: 
1. Click on the start button.  
 The start menu will appear.
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2. Click on the control panel option.
 The control panel window will open.
3. Click on category.
 A menu will open,
 Click on small icons,
 Window will show all control panel items.
4. Click on network and sharing center.
 Window opens up with the basic information of all the network.
5. Click on setup a new connection or network.
 Setup connection or network dialog box will open asking you:
 *  Connect to the Internet
 *  Set up a new network
 *  Connect to a workplace
 *  Setup dial up connection
6. Click on connect to the Internet.
7. Click on next.
8. Choose the option how you want to connect? eg. Broadband (PPPOE)
9. You will be prompted to enter user name and password provided by your In-

ternet Service Provider(ISP) 
 To view your password, check show character check box.
 Select remember this password check box if you want this computer to re-

member your password.
10. Type connection name to share this connection with others who use this com-

puter you can click allow other people to use  this connection and then click 
on connect.

 The connection window will appear.
CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself

Chapter 9
A.  1. (b) 2. (c) 3. (d) 4. (c)    
B.  1. (T) 2. (T) 3. (F) 4. (T) 5. (T)
C.  

1.  cables, telepnonelines, infrared light beans 
2. terminators 
3. star
4. star
5. mesh
6. Peer to peer 

D.
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Bus Topology Ring Topology
1. A bus topology consists of a main 

run of cable with a terminator at each 
end.

1. In a ring topology,  device his exact-
ly two neighbours for communication 
purpose

2. All notes (file server, work station and 
peripherals) are connected to the linear 
cable.

2. All messages travel through a ring in 
the same direction ( either "clockwise" 
or coveter clockwise).

Star Topology Mesh Topology
1. A star topology is designed with each 

node connected directly to a central 
network hub, switch or concentrator.

1. A network setup where each of the 
computers and network devices are 
interconnected with one another, al-
lowing for most transmission to be 
distributed, even if one of the connec-
tions go down.

2. This configuration is common with 
twisted pair cable; however, it can also 
be with coaxial cable or fiber optic ca-
ble.

2. This topology is commonly used for 
wireless networks.

E.  
1.  The main network topologies are: 
 1.  Bus topology   2.  Star topology
 3.  Ring topology  4.  Mesh topology
1. Bus topology: It consists of a main run of cable with a terminator at each end. All 

nodes (file Server, workstations and peripherals) are connected to the linear cable.
2. Star topology: It is designed with each node (file server, work stations and periph-

erals) connected directly to a central network hub, switch or concentrator.
3. Ring topology:  In a ring network, device has exactly two neighbours for commu-

nication purposes. All the messages travel through a ring in the same direction(ei-
ther "clockwise" or "counter clockwise")

4. Mesh topology: A network setup where each of the computers and network devices 
are interconnected with one another allowing for most transmission to be distrib-
uted, even if one of the connections go down.  

2.  The two major types of network operating systems are:
 1.  Peer to peer   
 2.  Client / Server
 1.     Peer to Peer Network Operating System:

  Peer to peer operating system allows users to share resources and files located 
on their computer and access shared resources found on another computers. 
However, they do not have a file server or a centralised management source. 
In a peer to peer network, all computer are considered equal to use the re-
sources available on the network 

 2.      Client / Server Network Operating system:
 It allows the network to centralise functions and applications in one or more 
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file servers become the heart of the system, providing access to resources 
and providing security. Individual work stations have access to the resources 
available on the file server. It allows multiple users to simultaneously share 
the same resources irrespective of physical location. 

3.  Peer to peer network operating system allow users to share resources and files lo-
cated on their computer and to access shared  resources found on another comput-
ers. However, they do not have a file server or a centralised management source. 
In a Peer to peer management, all computers are considered equal, they all have 
similar abilities to use the resources available on the network. 

 
CO-SCHOLASTIC TASK
A. 
 1.  Mesh Topology
 2.  Ring Topology
 3.  Star Topology
 4.  Bus Topology
B.  Do yourself

Class VIII
Assessment C

A.
  Microsoft Access 2010 is a database  management system which has the capability 

of  answering questions asked by a user when you pose a question to Microsoft 
access, the question is called a guyer .It is a question that is represented in a way 
so that it is understood by Microsoft Access. To find the answer to the question, a 
corresponding query has to be created.  

B.  
1. <BR> tag: It creates a new line. 
2. <P> tag: It starts a new paragraph.
3. <FONT>: It changes the appearance of text.
4. <OL>: It creates an order list.   

C.  Do yourself
D.  Do yourself

Assessment D
A.  Do yourself
B.  E- commerce stands for electronic commerce. E-commerce is the buying and selling of 

products and services by businesses and consumer through the Internet.
 Following are the benefits of e-commerce:

 * Reduced cost by reducing labour, reduced paper work, reduced errors in keying of 
in data, reduce post cost.

 * Shorter lead times for payment and return on investment in advertising, faster de-
livery of product.

 * The ability to handle complex situations, product ranges and customer profiles 
without the situation becoming unmanageable.

 * Improved communication between trading partner leads to enhanced long- term 
relationships.
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  * The closer you are to your customer and the more you work with them to change   
   from normal business practices to best practice e-commerce, it is harder for a   
  competitor to upset your customer relations.

 * The internet has potential to expand your business into wider geographical loca-
tions.

C.  
1. Peer-to Peer: It allows users to share resources and files located on their computer 

and to access shared resources found on another computers.
2. Client / Server: It allows the network to centralise functions and applications in 

one or more dedicated file servers.

Test Paper B
A.  1. (c) 2. (a) 3. (a) 4. (d)    
B.  

1.  Microsoft Access 2010. 
2. Report 
3. Create and run a query
4. Query
5. And criterion, Or criterion

C.  
1.  <HTML> tag 
2. <TITLE> tag
3. <P> tag
4. <U> 
5. <FONT>  

D.  1. (T) 2. (F) 3. (T) 4. (F)  5.(T)   

E.

B2B e-commerce C2C e-commerce
1. Business to Business (B2B) E-Com-

merce describes commerce transac-
tions between a manufacturer and a 
wholesaler.

1. Customer to Customer (C2C)  E-com-
merce involves the transactions be-
tween consumers through some third 
party.

2. For example: A cloth manufacture 
makes many B2B transactions like 
buying raw materials, machinery, etc.

2. For example: Now- a - days live auc-
tion various products are being con-
ducted. In this, a consumer post an 
item for sale and other consumers bid 
to purchase that item.

F.  1.  Router: It is specialised for determining the next networking point where the data  
 packet is forwarded to words its destination.
 2. Gateway: It is placed at the network node. Its function is to act as an interface with 

outer network that uses protocols.
 3. Bridge Networking Device: The bridge is used for connection of data link layer 

and multiple network segments.
 4. Hub: A hub is a device used for connecting optic Ethernet devices together and 
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making them act as a single network segment.

G. 1.  Follow this step to add alternative fine text.
  (1). Type< IMG SRC= "Picture name" ALT= "Image of computer"> to add alter  

 native
     The image will be replaced by an alternative text.
     Follow this step to wrap text around the image
  (2) Type< IMG SRC= "Picture name" ALIGN=  Left > to warp text to the left   

 side of the image
     The text will be wrapped to the left side of the image.

    2.  Following  are the step given for the path of E-commerce transaction.
  (1) The customer searches for the product from the online shopping site.
  (2) Then a list of all the products is made in an electronic shopping chart.
  (3) Then the customer enter a secure website which displays various payment   

 information. 
  (4) The information about payment is sent to the bank for authorisation to the   

 E-retailer.
  (5) E-retailer then send a confirmation to the customer through its web server.   

 Then the order comes in process.
  (6) Then the products are packed according to every order and transported for  

 ward for shipment.
  (7) The order is then carried to the courier company. All the shipment  details   

 are uploaded on the website.
  (8) Then the courier company takes the product to the customer.
  (9) At last the products are delivered to the end customer. The customer gives a   

 confirmation on receiving the product.
 3. Given below are some of types of networks which are used worldwide:

(1)  LAN (Local Area Network): It connects Network devices within a short area  
i.e small offices, homes, internet cafes, etc.

2. WAN (Wide Are Network): As the word implies Wan covers a large distance 
for communication between computer. The internet itself is the biggest exam-
ple of WAN which covers the entire earth.

3. MAN (Metropolitan Area Network): This kind of network is not mostly used 
but it has its own importance for some government bodies and organisations 
on a larger scale.

 4.   The two major types of network operating systems are:
 1.  Peer to peer   
 2.  Client / Server
 1.     Peer to Peer Network Operating System:

  Peer to peer operating system allows users to share resources and files located 
on their computer and access shared resources found on another computers. 
However, they do not have a file server or a centralised management source. 
In a peer to peer network, all computer are considered equal to use the re-
sources available on the network 

 2.      Client / Server Network Operating system:
 It allows the network to centralise functions and applications in one or more 

file servers become the heart of the system, providing access to resources 
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and providing security. Individual work stations have access to the resources 
available on the file server. It allows multiple users to simultaneously share 
the same resources irrespective of physical location.  




